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1 Rotating & Reflecting

FX Draw 3 allows you to rotate and reflect images.

You can rotate using the keyboard or toolbars.  You can reflect using the
reflection toolbar.

To use these tools, select the figures you wish to rotate or reflect and then
choose the appropriate action.

The reflection buttons are self-evident.  The rotation buttons allow you to rotate
images in 1 or 15 degree increments.  

You can also rotate figures using the keyboard.

15 degrees Clockwise Ctrl + PageDown
1 degree Clockwise Ctrl + Shift + PageDown
15 degrees Counter-Clockwise Ctrl + PageUp
1 degree Counter-Clockwise Ctrl + Shift + PageDown

Most figures rotate or reflect as you would expect.  Some complex figures (eg
graphs) do NOT reflect or rotate.  If you rotate a selection of figures that include a
graph, the figures will rotate and the graph will move to maintain its RELATIVE
position in the group but the image will NOT rotate.

Text boxes CAN be rotated but often this is not what you really want to happen. 
You can turn text rotation on or off in the Text Properties screen.  If rotation is
OFF, the text will move to maintain its relative position in the group but will not be
rotated.

Equations cannot be rotated.

2 A GAD Trick

You may have wondered how FX Draw chooses which geometrically interesting
point to jump to.  The actual process is quite complex but in essence, each point
is given a “mass” based on “importance” (for example, the middle of a line is
considered more “important” than the point one third along the line).  FX Draw
then calculates an “attraction” in much the same way as gravity –attraction is
based on mass divided by the square of the distance.  The most “attractive” point
wins.

Sometimes this system can cause a few problems when there are a lot of
geometrically interesting points around.  A very important point may not win the
attractiveness competition because you are so near another, less important point.

The practical impact of this is that sometimes you can find the important point
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you want BY MOVING SLIGHTLY AWAY FROM IT.

As a simple example, draw a line.

First, try to get the midpoint of the line by moving the mouse as accurately as you
can ALONG the line.  In other words keep the mouse cursor ON the line while
you are trying to find the midpoint.

You should find that there is a relatively small range where FX Draw will find the
mid point.  Most of the time it will report that it has found a Point on the Figure. 
Points on Figures are much less “important” than midpoints BUT because you
are very close to the figure, they become very attractive.

Now approach the midpoint of the line from the side (perpendicularly).  You
should find that FX Draw finds the midpoint a LOT further out.

3 Drawing Order

As you create a diagram, FX Draw remembers the order that you drew the figures
in.  When it draws your diagram, it will draw each individual figure in the same
order as you created it in.

Most of the time the order does not matter.  It DOES matter when a figure has
been filled.

Try drawing a line and then a filled rectangle that covers part of the line.  The line
should “disappear” under the rectangle.

Now draw a filled rectangle and then a line that crosses over the rectangle.  The
line will be visible on top of the rectangle.
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Different drawing orders can dramatically change how your diagram looks.  FX
Draw allows you to change the drawing order of your figures.

The Drawing Order toolbar lets you change the drawing order of figures in your
diagram.

The first button moves the currently selected figure to the front of your image.  It
makes the selected figure the LAST thing drawn.

The second button moves the currently selected figure to the back of your image.
It makes the selected figure the FIRST thing drawn (and hence the most likely
thing to be covered up later).

The third button moves the selected figure one level towards the front of the
image.

The fourth button moves the selected figure one level towards the back of your
image.

Using these four buttons you can exert a large amount of control over how your
diagram is drawn.

4 Maintaining The Aspect Ratio of a Gallery Image

Whenever you select a gallery image to draw, FX Draw will place the image into
the rectangle you sketch out.  Sometimes this is not appropriate.

Some diagrams rely on a particular aspect ratio (height compared to width) so
that they appear correctly – an example is the pulley diagrams in Dr Mark Dabb’s
gallery available on our website.

Holding down the SHIFT key while drawing your gallery image forces FX Draw to
use the same aspect ratio as the original creator of the image.  You can force FX
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Draw to draw it as the diagram’s creator intended.

5 Exporting Images

The most common way of getting images out of FX Draw 3 is to use the Word
integration.  The advantage of this method is that you can double-click on your
image and edit it at a later date.

BUT...

Word Integration uses some outdated technology that Microsoft has abandoned
and is being progressively abandoned by graphical software companies. 
Problems with the technology are discussed in a later lesson.

So what are your other options?

Copy and Paste

FX Draw 3 supports a way to copy and paste into external programs but it is not
normal copy and paste.  A normal copy operation in FX Draw places a copy of
your figures onto the clipboard but it uses a special internal format that only FX
Draw 3 understands.  If you try to paste this into an external program you will get
nothing.

FX Draw 3 CAN add your figures to the clipboard in a format useful to external
programs.  Draw your image and either press Ctrl+M or choose Copy Image to
Clipboard from the Edit menu.

Now switch to the external program and choose Paste.

IMPORTANT NOTE
Copying and Pasting is a ONE WAY STREET.  Once the image has been placed
into the external program, it cannot be edited by FX Draw.
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Technical Note (most users can ignore this section)
The image is placed on the clipboard as an enhanced metafile.  This maintains the high quality images you
expect from FX Draw.  The decision to not include an EMF rendering on the clipboard during a normal copy
operation was deliberate.  Producing the EMF can be computationally intensive and produces some
unwelcome visual artifacts when zoom is not 100%.  These reasons have prompted us to remove EMF
production from normal copy operations.

Export a File

FX Draw can also export images to files in a variety of formats.  Draw your image
and then either type Ctrl + E or choose Export to File from the File menu.

FX Draw can export to 3 file types, Enhanced Metafile (EMF), Graphics
Interchange Format (GIF) and Bitmap (BMP).



7FX Draw 3 Advanced Exporting Images

© 2006 Efofex Software

EMF High quality vector format useful for publishing purposes.
GIF Compressed bitmap format useful for web images.
BMP Uncompressed bitmap format that should only be used as a last
resort.

Why No JPG?

JPG is a great way to compress bitmaps but it uses a method that is designed for
photographs and is unsuitable for the type of graphics FX Draw produces.  Lines
in FX Draw graphics saved as a JPG file would have a little "halo" of miscoloured
dots around the line.  Because it is not appropriate, we do not provide it.

6 Creating Your Own Gallery (or Modifying Ours)

Galleries are easy to create and we are always looking for new galleries from
people just like you.

First, create an empty gallery to hold your images.  Push the gallery library
button 

and then the Add Gallery button.  Give the gallery a title and push OK.
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Now start drawing your masterpieces.

Once you have drawn an image that you want to save, SELECT it.  If the whole
image is required, the easiest way is to push Ctrl+A.

Go to the File menu and choose Save To Gallery (or type Ctrl+T).

You will be given a list of available galleries and you can save your image into
your new gallery or one of our existing galleries.
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Once you have built a collection of gallery images, it is a good idea to annotate
them so other people know what you were trying to achieve.

Push the Gallery Library button 

and select your gallery from the list.  You will see all of your images.

You may need to sort the images into a better order.  You do this by clicking on
an image and pushing the move up or move down button (marked in red below). 
You can also delete images.



10FX Draw 3 Advanced Creating Your Own Gallery (or Modifying Ours)

© 2006 Efofex Software

One the right hand side of the gallery library page, there are two grey regions. 
The top region (blue arrow) should hold a description that is common to all
images in the gallery.  The bottom region (green arrow) holds information unique
to each image.  Just below each region you will see a little “Edit” button that
allows you to edit the message in each region.  

Once you have created your magnificent collection, make sure you send it to us
so we can share it with the world!

7 Drawing Isometric Diagrams

By default, the underlying grid is a Cartesian grid with 5mm spacing.  You can
change it to be an isometric grid that makes drawing isometric diagrams MUCH
easier.

First, go to the Tools menu and choose Grid…
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Second, set the grid size to something bigger – we suggest 10mm or larger – as
5mm is too small for isometric diagrams.

Finally put a tick in the Isometric checkbox.

When you return to the main drawing screen, the grid will be isometric (we have
also turned on "Big Dots")

It is best to turn GAD OFF when drawing isometric diagrams.  Go to the GAD
toolbar  and push the grid button.
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Your cursor will now jump to the underlying isometric dots and isometric drawing
is easy.

8 Locking Figures

If you have carefully placed a figure in exactly the right spot and want to make
absolutely sure that you don't move it accidentally, you now have the option of
locking it.

Draw your diagram and select any figures you want to lock.

Now press the lock button  and the figure will be locked in place.  FX Draw 3
will change the squares to grey to show you that they are locked.
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This line is now locked in place and you will not be able to move it at all apart
from one important exception - it will still remember and use any GAD Links that
were used.  Even though you will not be able to directly move the line, it you
change the circle, the line will remain tangential.

You can unlock any locked figures by selecting them and clicking on the lock
button.

9 Format Painting

The format painter allows you to format one figure exactly as you want and then
copy the formatting over to other figures.  Format painting is available in a lot of
products (such as Word) and ours works in exactly the same way.
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To use the format painter, first format a figure and then select it as shown above.

When the SOURCE figure is selected, press the format painter button

Then click on a DESTINATION figure that you would like the formatting copied on
to.

To format more figures, keep clicking the format painter button and the next
figure.

The format painter will always copy the line style, line thickness, line colour, fill
style and fill colour.  The more similar the source and destination figures, the
more information is painted across.
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10 Thick Dotted Lines

FX Draw 3 can  draw thick dotted lines - but there is a catch.

Hold on - it's going to get technical for a bit.

FX Draw uses a technology called OLE (Object Linking and Embedding) to "link"
into Word.  OLE provides the ability to double click on FX Draw images in a Word
document and open them up inside FX Draw.  OLE provides much of FX Draw's
interactivity with Word.

The problem is that OLE is an old technology that Microsoft has almost
abandoned and it doesn't support thick dotted lines.  OLE is so problematic
that Adobe (the world's leading general graphics software company) has totally
removed OLE support from all of their products -   products like Photoshop and
Acrobat.

That's the problem.  FX Draw can draw the thick dotted lines - it just can't get
them back into Word using OLE.

You CAN get thick dotted lines into Word, you just need to copy and paste your
image rather than use OLE.  The problem with this approach is that you lose the
interactivity.  Your diagram will need to be saved and stored separately to the
Word document.

To copy an image to the clipboard to be pasted into Word.

· Draw your image
· Choose "Copy Image to Clipboard" from the menus or type Ctrl + M.
· Paste into Word.

11 Zooming

FX Draw 3 includes a zooming option

Zoom operates in the same way as in other products but it has a use that may
not be immediately obvious.

When people used FX Draw 2 to draw diagrams, they would often complain that
the diagram was too big when it was returned to Word.  This seemed to be a
problem of perception - the diagram looked bigger in Word because it was no
longer the "only" thing on the page.  
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We suggest that you use FX Draw 3's zoom function to overcome this perception
problem.  Set your zoom to about 140% in FX Draw 3.  This allows you to focus
on the diagram and include the detail you need - but when you return to Word the
diagram will not appear too large.  

12 Measurements

The main line selection toolbar in FX Draw now defaults to sizes in points.

You can select point sizes between 0.25 pt and 4 pt in this drop down list - but FX
Draw 3 is much more flexible than this.  You can type just about measurement
into this space and FX Draw will use it as a line thickness.  You can, for example,
use a line thickness of 1cm.

This flexibility extends to most places that FX Draw asks for a measurement. 
You can, for example, specify a grid of 0.25 inches or construct some graph
paper with 36 pt dots.
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FX Draw will always assume that line thicknesses are specified in points.  For all
other measurements it assumes the current measurement default unless you
specifically add a unit.  You can set the default measurement system by going to
the Tools menu, choosing Preferences and then General.

The default Linear Measurement Unit is also used in all locations that FX Draw
reports lengths or areas, particularly in Figure Information.

This is the last lesson in the FX Draw 3 Advanced lesson set.  There are three
email tutorials that you should consider after this one.

Efofex Graph Technology
Efofex Equation Technology
Efofex Statistics Technology

We hope you have enjoyed this lesson set and we welcome any suggestions you
have to make.
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